EXercise 1

Working with climate simulation output in
GIS

Background

As stated in the Climate Change Global Food Security and the U.S. Food System Executive
Summary on page 3:

Climate risks to food security increase as the magnitude and rate of climate
change increase. Higher emissions and concentrations of greenhouse
gases are much more likely to have damaging effects than lower emissions
and concentrations. Worst-case projections based on high greenhouse-gas
(GHG) concentrations (~850 ppm), high population growth, and low economic
growth imply that the number of people at risk of undernourishment would
increase by as much as 175 million above today’s level by 2080. The same
socioeconomic conditions with GHG concentrations of about 550 ppm result in
up to 60 million additional people at risk, while concentrations of about 350
ppm—Iess than today’s level—do not increase risk. Scenarios with lower
population growth and more robust economic growth result in large reductions in
the number of food insecure people compared to today, even when climate
change is included, but higher emissions still result in more food insecurity than
lower emissions.

(http://www.usda.gov/oce/climate _change/FoodSecurity2015Assessment/CCFS
Executive_Summary.pdf)
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GLOSSARY

Climate Models

Climate models are computerized simulations of the climate system developed to understand
and predict climate behavior. “Climate models incorporate the physics and chemistry of the
atmosphere and the oceans and aim to answer questions such as when the next El Nifio might
occur, and what might happen if greenhouse gas concentrations double.” You can find more
information on climate models at the World Meteorological Organization (WMO) website.
https://www.wmo.int/pages/themes/climate/climate _models.php

Intergovernmental Panel on Climate Change (IPCC)

The Intergovernmental Panel on Climate Change (IPCC) was established by the World
Meteorological Organization (WMO) and the United Nations Environment Programme (UNEP)
to assess scientific, technical, and socio-economic information relevant for the understanding of
climate change and its impacts. The IPCC produces assessment reports on climate change
and related topics. The 4" Assessment Report (AR4) on Climate Change was released in 2007
and the 5" Assessment Report (AR5) was released in 2013.

Community Climate System Model (CCSM)

The Community Climate System Model (CCSM) is a community-wide effort led by the National
Center for Atmospheric Research (NCAR). The CCSM is a coupled climate model for
simulating the earth's climate system. It is composed of four separate models simultaneously
simulating the earth's atmosphere, oceans, land surface, sea-ice, and one central coupler
component. The CCSM allows researchers to conduct fundamental research into the earth's
past, present, and future climate states.

Representative Concentration Pathways (RCPs)

Representative Concentration Pathways (RCPs), are four possible future climates depending on
how much greenhouse gases are emitted in the years to come. RCPs represent potential
greenhouse gas concentration scenarios projected into the future. Four tiers of RCPs were
developed, and each is named according to the level of radiative forcing (enhanced greenhouse
effect or warming) anticipated by the year 2100. The four RCPs include one peak pathway in
which radiative forcing reaches 8.5 Watts per square meter (Wm-2) by the year 2100; two
intermediate “stabilization pathways” in which radiative forcing stabilizes at 6 Wm-2 and 4.5
Wm-2 after the year 2100, and one low pathway in which radiative forcing peaks around 3 Wm-
2 before 2100 and then declines. This low scenario describes GHG emissions that drop below
zero around 2070 and continue to decrease (carbon-negative) into the future.

For more information: http://sedac.ipcc-data.org/ddc/ar5 scenario process/index.html
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Ensembles

Climate models can be run multiple times and each time using a slightly different initial state of
the atmosphere. Each run is called an ensemble member. Each ensemble member is a
plausible representation of the real world and each produce slightly different future outcomes.
Ensembles give us a better understanding of the uncertainty in the model based on its initial
atmospheric state. In these exercises you will use the ensemble average for the climate model.

Climate Anomalies

A climate anomaly is the difference between a plausible future climate when compared to
present-day climate. In this exercise the present day climate is a 20-year average of 1986-2005
climate data. Anomalies are useful to determine the magnitude of change.

NetCDF

NetCDF is a popular atmospheric data format because it can easily store multidimensional data
(X, Y, time, and/or altitude).
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Opening and Exploring ArcMap

Step 1  Starting ArcMap and open a Map Document file.
In this first step you will open an existing map in ArcMap.

e Click Start > All Programs > ArcGIS > ArcMap 10.X.

e [f a dialog box appears prompting you to select a map, click Cancel.

e From the File menu in the upper left, click Open...

File | Edit View Bookmerks Insert Selection Geoprocessing Customize Windows Help
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Save As...
an existing map document.
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Save A Copy.. Open

Share As

Add Data

e Browse to C:\USDA_NCAR \exercisel\maps and select the
GlobalAnomalies.mxd file (if using ArcGIS 10.4), and open
GlobalAnomalies10_3.mxd (if using ArcGIS 10.3).

TIP: The .mxd file extension identifies ArcMap document files.

e Click Open to open the map document.
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When the document opens, you’ll see the basic ArcMap interface. It offers three key
sections: 1) the menu tabs and toolbars at the top, 2) the Table of Contents on the left, and
3) the map display in the middle.
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This map displays a layer called countries and another layer called “RCP 2.6” which
contains information for Air Temperature Anomalies for RCP 2.6. An air temperature
anomaly is the difference between a plausible future temperature when compared to
present-day climate. Anomalies show change and are a good way to display how
temperature change varies in space and time. RCP 2.6 is an emission scenario used to
represent potential greenhouse gas concentration scenarios projected into the future (as
explained above in the Glossary).

e Take a moment to explore the various menu tabs at the top. Notice that some of
these are similar to other Windows-based programs such as Microsoft Office.
Hover your mouse over a tool to see the tools name and short description.

e Now save the document by clicking File, and then Save As. Save the map
document in C:\USDA_NCAR\exercisel\maps as exercisel <your
name>.mxd.

TIP: It is good practice to use only alpha-numeric characters or underscores in your file names and
leave no spaces.
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Step 2 Exploring toolbars and windows

Toolbars organize the tools available in ArcMap.

e Click the Customize menu.

e Then hover your mouse over Toolbars.

The toolbars allow you to access many of the ArcMap functions and tasks. The Standard
and Tools are the key toolbars. Notice a checkmark beside each of them, indicating that
they are already turned on. You can turn toolbars on and off by clicking on them in this
menu.

e Click anywhere outside the toolbar menu to close it.

Once turned on, toolbars can be moved around to best fit within the ArcMap interface. More
specifically, they can either be docked to the side of the screen or they can be left floating in
the middle. Currently, all three of the main toolbars are docked above the Table of Contents
and Map Display section of the ArcMap interface (section 1 in the image above).

e Click on the grey handle of the Tools toolbar, indicated by the vertically aligned
dots on the left edge of the toolbar, and drag the toolbar to the Map Display area.
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Note that the name of the toolbar now appears, along with the option to close the toolbar
completely.
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e Click on the grey bar at the top of the Tools toolbar and drag it back to the top of
the screen to re-dock it.

TIP: Another way to dock a toolbar is to double-click on the grey top part of the toolbar.

Try expanding the Map Display area for a better view. Turning off the Table of Contents is
one way to do this.

e Click the X in the upper-right corner of the Table of Contents (TOC) window.

e Toturn it back on, click on the Windows menu at the top, and then Table of
Contents.

Alternatively, you can set the window so that it disappears automatically when you don’t
need it.

a e In the upper-right corner of the Table of Contents window, click the thumbtack
icon (Auto Hide) to create a quick access tab for the Table of Contents.

e Hover your mouse over the new tab. This will open the Table of Contents
window. Once you move your cursor away, the display minimizes again.

Click the Table of Contents tab and then the Auto Hide button to restore the
window to its original docked position.

Windows, such as the Table of Contents, can be docked in multiple locations or they can be
left to float, similar to toolbars.

e Click the Title Bar (top) of the Table of Contents window and drag it away from
the left side of the Map Display and drop it on your map.

e Double click the Title Bar to dock the Table of Contents (TOC).
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Step 3 Navigating and using the zoom and pan tools

Explore your layers interactively by zooming in closer to a particular location or panning to
nearby areas.

@ e Click the Zoom In button on the left side of the Tools toolbar.

TIP: For a description of each tool in the toolbars, simply hover your mouse over the tool and a tool-
tip window will appear.

e Click once near the northwest corner of North America and keep holding down
the mouse.
e Drag a box around the rest of North America and release the mouse.
|ﬂ| e Click the Pan button on Tools toolbar (notice that the cursor becomes a hand).

e Click and drag the map upwards to see South America.

TIP: Another option for zooming in and out is the Fixed Zoom In and Fixed Zoom Out buttons
found on the Tools toolbar. Yet another, and perhaps more convenient option, is to use the
scroll wheel on your mouse. Place your cursor over the area that you want to zoom to and then
roll the scroll wheel backwards. Hold down Ctrl while rolling to zoom at finer increments.

Now that you have explored the area up close, zoom back out to get a wider picture. You
can zoom out in small increments using the Zoom Out button on the Tools toolbar (similar
to the Zoom In function), or you can zoom out to the furthest extent of the data in your
ArcMap document. Zoom to the full extent to view all of your data at once.

a e Click the Full Extent button (globe icon) on the Tools toolbar.

If you want to return to the previous close-up view, you can use the Back to Previous Extent
button.

*| e Click the Go Back To Previous Extent button (left arrow icon) on the Tools
toolbar.

e Now your map view is back to wherever you were just prior to zooming to the full
extent. When you have finished exploring the data, zoom back to the full extent.
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Step 4 Getting to Know Layers and Data Frames

Let’s look more closely at the items in the Table of Contents. Notice that there are two
collections of layers called Layers and Drought. These are called Data Frames. While
both Data Frames are listed in the Table of Contents window, we currently only see the
global map with temperature change. The second one shows croplands.

B £ e Right-click on the title of the second Data Frame, Drought.

e Click Activate.

The map of countries appears in the Map Window and the title, Drought, assumes a bold
type-face indicating that it is the active Data Frame.

= M CurentCroplandtif  ® INn the Drought Data Frame, click the check-box next to the Current Cropland.tif
<VALUE> layer. This will toggle the layer on.

Now the Current Cropland layer is turned on.

e Click the Current Cropland layer and, while holding the mouse down, drag it
below the countries layer.

Layers are drawn from the bottom up. So, Current Cropland is hidden because this layer is
drawn below the countries.

e Re-activate the Layers Data Frame by right-clicking on the Data Frame and
selecting Activate.

Step 5 Data Frame Properties

When a new Data Frame is created, it is given the default name, Layers. This can be
changed in the Data Frame Properties.

e To access the Data Frame Properties, double-click on Layers, or click the View
menu and then click Data Frame Properties...

In the Data Frame Properties window, there are ten different menu tabs that allow you to
view and edit various properties of the Data Frame.
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Data Frame Properties @

Fealure Cache | Annotation Groups | Extent | Frame | SizeandPosition |

General ‘ Data Frame | Coordinate System | | Grids |

Name: Layerg

Description:

Credits:

Units

Map: Meters

-

Display: |Meters -

Tip:  See Customize > ArcMap Options > Data View tab for

additional options for displaying coordinates in the status
bar

Reference Scale: <None>

Rotation: 0

Label Engine: Standard Label Engine -

Simulate layer transparency in legends

ok |[ cencel |[ appy |

e Click the General tab and enter “Climate Simulations”into the Name box. You
could also enter a description and credits, but for now, we’ll leave these blank.

e Click Apply to set the new name.

You can see that the Name has been updated in the Table of Contents. You can explore the
other tabs in the Data Frame Properties window on your own.

e Close the Data Frame Properties dialog box by clicking OK.

Step 6 Viewing Layers in the Table of Contents

A map document consists of a collection of layers that are displayed, managed, and
accessed from the ArcMap Table of Contents window. The layers themselves are not

actually stored within the map document; rather, they are accessed through the map
document.

ArcMap offers a few different options for how layers in the Table of Contents are displayed.
Notice the five small icons in the upper-left corner of the Table of Contents window.

Table Of Contents

BEEECE

© 2016 UCAR 1-11



The blue box surrounding the left-maost icon indicates that this is the active view. In this
view, the layers are listed by drawing order — the layer drawn on top is on the top of the list.

e Click on the second icon from the left, the List by Source option.

In this view, the path names appear, indicating where the layer is stored. This can be
helpful if you forget where the dataset behind the layer in your map resides.

e Click on the layer countries and try to drag it below RCP 2.6.

Notice that you are unable to reorder layers when the Table of Content is displaying layers
by List by Source.

e Change back to the List by Drawing Order view.
e Click on the layer countries and try to drag it below RCP 2.6.

When the data are displayed by List by Drawing Order, you are able to reorder layers.

e Reorder the data so that countries goes to the top of the list.

Step 7 Layer Properties

Similar to the Data Frame Properties of ArcMap, each layer contains its own properties that
can be viewed and changed. To access these properties, you will right-click on the layer
name in the Table of Contents.

e Right-click on the countries layer.

e Select Properties...

In the Layer Properties window, there are several tabs that allow you to view and edit the
layer’s properties. Commonly used tabs include General, Source, Symbology, and Labels.

e Click the General tab.

e Change the Layer Name to Boundaries
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Changing the Layer Name only affects how the name appears in the Table of Contents. It
does not change the name of the underlying data. Keep this in mind as the layer name in
the Table of Contents will not always match the file name where the data are stored.
As previously mentioned, the map document is just accessing the layers, not storing them.

e Click the Source tab.

The source tab displays basic metadata information about a layer, including the type of
layer, its actual file or source name, and coordinate system information. Metadata is “data
about data” and is critical for understanding the details of a particular dataset such as where
the dataset came from, how it was created, the date it was created, among other details.

e Click the Symbology tab.

Layer Properties =

[ General [ Source | Selection | Display | Symbology | Filds | Defintion Query [ Labels | Joins & Relates | Time | HTML Popup |
w

Featues | Draw all features using the same symbol. Import.

Symbol

Quantities | ==
5 @ e

Multiple Attributes !

Legend

Label appearing next to the symbol in table of contents:

w—rj&ﬂ?{ Descripton..

‘Additional description appearing next to the symbol in your map's legend

[ ok Cancel Aeply |

In the middle of the display window under Symbol, click the symbol button.
e Change the Fill Color to red.

e Click OK in the Symbol Selector window.
e Click Apply in the Layer Properties window.

This will apply the rendering, but not close the window.

Notice that all of the countries on the map have turned red. There are many symbology
options available for choosing how you want to display a layer on a map.
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Click on the symbol button again.

This time, make the fill No Color and change the outline color to Purple.

Click OK to close the Symbol Selector.

Click Apply.
Click the Labels tab.

Place a checkmark next to “Label features in this layer.”

Make sure the “Text String, Label Field:” is set to CNTRY_NAME.

Close the Layer Properties window by clicking Apply.

Layer Properties

E |

| General | Source | Selection | Display |

| Fields | Defintion Query | Labels | Joins & Relates | Time | HTML Popup |

Label features in this layer

Method: Label all the features the same way. -

Text String

All features will be labeled using the options specified.

Label Field: CNTRY_NAME

Text Symbol

AsBbYyZz

Other Options

v Expression...

Gaa v 8 -
[ EERE s

Pre-defined Label Style

[ Placement Propeties... | |

ok ][ Concsl ][ ooy |

TIP: You can also turn a layer’s labels on and off by right-clicking on the layer name in the Table of
Contents and then clicking Label Features.
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Turn off the labels by unchecking the box.

Click OK to close the Layer Properties window.

Save ArcMap.
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Working with Multidimensional Data in ArcMap

Step 8 Adding NetCDF data through the Multidimension Toolbox
e Right click on the layer RCP 2.6 and select Properties...
The Layer Properties window will open.
e Click on the NetCDF tab.

Notice that the time is 4/19/2091.

e Change the date to 05/04/2030 using the dropdown menu.
e Click Apply.

e

General |Source | Bxtent | Displayl bol | NetCDF | Time
“onerson
|
Dimension Values:
Dimension Value =
time 5/412031 =1
| 5i4/2031 -
51312032 |
5312033 =
5/312034
51312035
51212036 -
5
ok ] [ s ] [ s |

e Explore different dates.

e Reset the date to 04/19/2091 and click OK to close the Layer Properties window.
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You have explored only one plausible emissions scenario so far. You will now add the other
RCPs and compare future temperature change based on different emission scenarios.

.

as a window in ArcMap.

e |nthe ArcToolbox
window, expand the
Multidimension Tools
toolbox.

e Double click on Make
NetCDF Raster Layer to
open the tool dialog box.

Click the Show/Hide ArcToolbox button on the main toolbar to open ArcToolbox

ArcToolbox

&l ArcToolbox
a 3D Analyst Tools
- B analysis Tools
a Cartography Tools
- B Conversion Tools
i+ B Daka Interoperahilicy Tools
a Daka Managerent Tools
- B Editing Tools
&P Geocoding Tools
a Geostatistical Analyst Tools
i+ B Linear Referencing Tools
Ela Multidimension Tools
", Feature to NetCDF
‘% Make NetCDF Feature Laver
----- ‘% Make NetDF Raster Laver
#., Make NetCDF Table View
#., Raster to NetCDF
‘% Select by Dimension
- # Table to NetCDF
a Mebwork Analyst Tools
a Parcel Fabric Tools
i+ B Schematics Tools
a Server Tools
i+ & Spatial Analyst Tools
i+ Spatial Statistics Tools
a Tracking Analyst Tools

e Inthe new dialog box click the browse button. @

e Navigate to C:\USDA_NCAR\exercisel\data\netcdf\
atas20y_Amon_CCSM4 _rcp45_annual_2000-2090.nc.

e Click Open.
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Make sure the following parameters are selected for the dialog box:

A

Input netCDF File

D:\projects\usda_2016\exercise 1\data\netcdf\atas20y_Amon_CCSM4_rcp45_annual_2000-2050,
Variable

tas v

X Dimension
lon v

Y Dimension M
lat v

Qutput Raster Layer
RCP 4.5

Band Dimension (optional)

Dimension Values (optional)

Dimension Value
time 4/19/2091

| [=[x][#] «

< | " [ »

Value Selection Method (optional)

BY_VALUE v
[ oK H Cancel ][Environments... ” Show Help >> ] |

Variables tas

X Variables lon

Y Variables lat

Output Raster Layer RCP 4.5

Band Dimension (optional) <none>

Dimension Value (optional) time (select from dropdown)

Time will appear in the Dimension list below the Dimension Value. In the corresponding
Value list, click once.

Select the last time value which is 4/19/2091

Value Selection Method BY_VALUE

e Click OK to bring in the netCDF file when you have set all the parameters.
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You should now see the annual temperature anomaly for 2091 displayed in your map.
e Explore the map.

In order to compare the temperature change between the two scenarios, it is best to use the
same symbology scale for each layer.

e Right click on RCP 4.5 in the TOC and select Properties.

e Inthe Layer Properties dialog box, select the Symbology tab.
e Click the Import button.

e Select the layer RCP 2.6.

e Click OK.

e Click OK to close the Layer Properties window.

e Click File > Save.

e To compare the two layers, turn the layer RCP 4.5 on and off by clicking the box
in the Table of Content next to the layer name.

= RCP45

Value
. High:6

"Low: -0.508835

These maps show the annual air temperature anomaly for 2091 (2081-2100). The RCP 4.5
map indicates hotter temperatures than the RCP 2.6 map. This is due to the different
greenhouse gas concentrations used by each scenario. RCPs should not be viewed as
forecasts or absolute bounds. They are representations of plausible alternative scenarios of
the future, but are not predictions or forecasts. No single RCP is intended as a best guess
or most likely outcome. In this exercise, you will look at three scenarios: a high emissions
scenario — RCP 8.5, a neutral emissions scenario — RCP 4.5, and a low emissions scenario
— RCP 2.6. By looking at the range of possible future climates, one can better understand
and prepare for future climate change. There are two more RCPs (6.0 and 8.5). We will
now look at these two simulations.
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Step 9 Reading RCP 6.0 and RCP 8.5 into ArcMap

You will now bring in two more netCDF files into ArcMap. These two files contain air

temperature anomalies for the RCP 6.0 and 8.5.

© 2016 UCAR

In the ArcToolbox
window, expand the
Multidimension Tools
toolbox.

Double click on Make
NetCDF Raster Layer to
open the tool dialog box.

ArcToolbox

Bl ArcToolbox
B 30 Analyst Tools
- P analysis Tools
a Cartography Tools
B Conversion Tools
a Cata Interoperabilicy Tools
a Data Managernent Tools
- B Editing Tools
a Geocoding Tools
i+ B Geostatistical Analyst Tools
i B Linear Referencing Tools
EI a Multidimension Tools
% Feature to MetCDF
% Make NetCDF Feature Layer
----- ‘% Make Net”DF Rasker Layer
#., Make NetCDF Table View
“‘% Raster to NetCDF
% Select by Dimension
: % Table to MetCDF
. a Mebwork Analyst Tools
B9 Parcel Fabric Tools
& schematics Tools
a Server Tools
i+ & Spatial Analyst Tools
a Spatial Statistics Tools
a Tracking Analvst Tools

In the new dialog box click the browse button. @

Navigate to C:\USDA_NCAR\exercisel\data\netcdf\
atas20y_Amon_CCSM4 _rcp60_annual_2000-2090.nc.

Click Open.
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Make sure the following parameters are selected for the dialog box:

Variables tas

X Variables lon

Y Variables lat

Output Raster Layer RCP 6.0

Band Dimension (optional) <none>

Dimension Value (optional) time (select from dropdown)

e Time will appear in the Dimension list below the Dimension Value. In the
corresponding Value list, click once.

Select the last time value which is 4/19/2091

Value Selection Method BY_ VALUE

e Click OK to bring in the netCDF file when you have set all the parameters.

You should now see the annual temperature anomaly for 2091 displayed in your map.

e Explore the map.

In order to compare the temperature change between the two scenarios, it is best to use the
same symbology scale for each layer.

Right click on RCP 6.0 in the TOC and select Properties.

e Inthe Layer Properties dialog box, select the Symbology tab.
e Click the Import button.

e Select the layer RCP 2.6.

e Click OK.

e Click OK to close the Layer Properties window.

e Click File > Save.
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To bring in the last netCDF file you will open the Results window and change the last
geoprocessing tool you used.

e Click Geoprocessing > Results.
e Open the Current Sessions folder

e Double click on the top Make NetCDF Raster Layer tool.
You have opened the tool that you just ran.

e Change the input netCDF file to atas20y_Amon_CCSM4_rcp85 annual_2000-
2090.nc

¢ Change the Output Raster Layer to RCP 8.5.

e Leave all other parameters the same and click OK.

¢ Right click on RCP 8.5 in the TOC and select Properties.

e Inthe Layer Properties dialog box, select the Symbology tab.
e Click the Import button.

e Select the layer RCP 2.6.

e Click OK.

e Click OK to close the Layer Properties window.

e Click File > Save.

Now that you have all 4 RCPs in your map document, you can see how different the air
temperature change may be based on the different greenhouse gas concentrations.

e Explore the different layers.
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Step 10 Animating a NetCDF File Over Time

So far we have taken a look at a single time period in our data (2081-2099). However,
visualizing data over time allows us to observe patterns and trends. NetCDF is an ideal
data format to visualize changes over time because it stores multidimensional information so
efficiently. In this next step, we will set up a time animation and examine how our data
changes over the century.

e Turn on the layer RCP 8.5.

e Turn off the layers for RCP 2.6, RCP 4.5, and RCP 6.0.

e Double click on the layer RCP 8.5 in the Table of Content.

e Click the Time tab in the Layer Properties dialog box.

e Check the box “Enable time on this layer”.

e For the Time dimension: choose time.

e Click the Calculate button for ArcMap to read all time steps in the data set.
e Change the Time Step Interval: to 1 Years.

e Click OK.

Layer Properties | %]

General | Source | Extent | Display | Symbology | NetCDF | Time |

Enable time on this layer,

R T [ e [ —
Layer Time: [Layer has time as a dimension. v
Time dimension: time -
Field Format: [<Dabe/ Time> "]
Time Step Interval: 1 [Yeafs v]
Layer Time Extent: |__5/4/2031 12:00:00 AM __To; 4/19/20d1 12:00:00 AM

["| pata changes frequently so calculate time extent automatically.

Advanced settings

Time Zone: [none v]

_| Values are adjusted for daylight savings

Time Offset: 0.00 [Years v

Display data cumulatively

ok J[ Conce J[ ey |

e Click the Open Time Slider Window button on the Main Toolbar.
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e Click the Time Slider Options

Time Slider

button.

Time is disabled on this map

5/4/2031 12:00:00 &M
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The first tab, “Time
Display,” allows you
to change the time
interval and how the
date and time are
formatted.

Because our data
represent annual
averages, all we want
to display is the year.
Choose 2016(yyyy) for
Display date format:

Check the box to
Show time on map
display.

box.

Time Slider Options

fime Display | Time Extent | Playback | Other |
Time zone: <None> v
["] Adjust for daylight saving changes
Time step interval: 1.0 Years '] l Restore Default ]
Time window: 0.0 Years
Time window options: lDispIay data for entire time window v |
n Display date format: 2014 (yyyy) v
Display time format: <none> v
Show time on map display l‘ Appearance, .. !
|
Lok ][ concel |

Click the Time Extent tab.
Click the Min Time Button.

Click Save to save your map document.

Check the box to Show time on map display.

Click OK to close the Time Slider Options dialog box.

Move the time slider to first time 2000 (if needed).

Click the Play E button on the Time Slider to start the animation.

Notice that the time slider now just shows the year in the Time Slider time display

1-23



Time Slider (=]

| < |2 2083 |==+4
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You should see the data change with each year over the century. This is a good method to
look for trends or patterns in your temporal data.

Challenge (if time permits): Explore future drought conditions

You are now going to add a new layer to your map. This new layer will have annual
projected Standardized Precipitation Index (SPI) from 2006-2100. These data are stored in
a netCDF data format.

e Click Windows > Catalog, to open the Catalog window in ArcMap.
g x o Pinthis window in ArcMap by clicking the PIN icon in the top right corner.

e Click the Connect to Folder button in the Catalog window and make a folder
connection to C:/USDA/exercisel.

e Navigate to the data folder.
e Drag the following layer packages into the map display;
o Current Cropland.lpk

o oceanmask.Ipk.

You are now looking at a map of current croplands. These data were downloaded from
CIESIN at the University of Columbia. It is the Global Cropland v1 dataset from 2000.
(http://sedac.ciesin.columbia.edu/data/set/aglands-croplands-2000/data-download). The
areas in gray use less than 10% of their lands as crops.

e Inthe ArcToolbox window, expand the Multidimension Tools toolbox.
e Double click on Make NetCDF Raster Layer to open the tool dialog box.
@ e Inthe new dialog box click the browse button.

e Navigate to C:\USDA_NCAR\exercisel\data\netcdf\CESM1-
CAMS_rcp85 rlilpl spi_36month_annual 2006-2100_ lonFlip.nc.

e Click Open.
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Make sure the following parameters are selected for the dialog box:

r |
#, Make NetCDF Raster Layer =B8] X

Input netCDF File ]

D:\projects\Diversity Workshop 2016\DiversityS\data\netcdf\CESM1-CAMS_rcp85_rlilp1_spi_36mo
Variable

spi v
X Dimension

lon -
Y Dimension

lat L 4

Output Raster Layer
drought

Band Dimension (optional)

Dimension Values (optional)

Dimension Value @
time 12/16/2006 12:00:00 PM E]
f
&
< | ([ | »
Value Selection Method (optional)
BY_VALUE v
[ oK ] [ Cancel ] [Environments...] [ Show Help >>
Variables spi
X Variables lon
Y Variables lat
Output Raster Layer drought
Band Dimension (optional) <none>
Dimension Value (optional) time (select from dropdown)

Time will appear in the Dimension list below the Dimension Value. In the corresponding
Value list, click once.

Select the last time value which is 12/16/2006 12:00 PM
Value Selection Method BY_VALUE
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e Click OK to bring in the netCDF file when you have set all the parameters.

You should now see the SPI for the year 2006 in your map display. Notice that this netCDF
is also based on RCP 8.5.

You will apply symbology to this layer using a classified categorization.

e Open the properties dialog box for the drought layer and click on the
Symbology tab.

Layer Properties® ‘ | & |
| General | Source | Extent | Display | Symbology | NetCDF | Time |
Show:
e Stretch values lo
Unique Values F S olonyicolar amp [@
Classified
—
Discrete Color
Color Value Label
|| 65  Hgh:6.5
Edit High/Low Values
. 0 Low:0 I 2
Color Ramp: aE _ 2
[ Display Backaround Value: | o asm
[ use hillshade effect Z ;71 | Display NoData as
Stretch - .
Type: [ Minimum-Maximum 7 [ ristograms |
Invert
Apply Gamma Stretch: [ 2 =
ok J[ Conce J[ remy ]

Apply the symbology from the layer file

e On the left side of the Layer Properties window, under Show: change your
classification to Classified.

e Click the Import... button and browse to C:\exercisel\data\drought.lyr, click
Add.

e Click OK in the Import Symbology window, then click OK again in the Layer
Properties window to apply the symbology and close the window.

e Now in the Table of Contents, drag the Current Cropland.tif layer above the
drought layer.

e Turn off the layer RCP 8.5 in the Table of Contents.

e Once you have applied the new symbology to the drought layer save your map.
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Step 11 Animating Over the Future Drought File

In earlier steps, you animated the map. In this step, you will add an animation for a graph.
This way, you can watch the map and graph move through time.

e Double click on the layer drought in the Table of Content.

e Click the Time tab in the Layer Properties dialog box.

e Check the box “Enable time on this layer”.

e For the Time dimension: choose time.

e Click the Calculate button for ArcMap to read all time steps in the data set.

e Change the Time Step Interval: to 1 Years.

e Click OK.

Layer Properties

General | Source | Extent DisplayISymbologleetCDFlTnme [

Enable time on this layer

Layer Time:

Time dimension:

Field Format:
Time Step Interval:

Layer Time Extent:

Advanced settings

Time Zone:

Time Offset:

{Layer has time as a dimension.

time

| <Date/ Time>

)

1] [Years

5/

12/16/2006 12:00:00PM To:

11/23/2100 12:00:00 PM

Data changes frequently so calculate time extent automatically.

[none

)

[ ] values are adjusted for daylight savings

0.00 |Years

z)

[7] Display data cumulatively

ok J[ Concel ]|
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e Click Save in order to save your map document.
e Turn on the Time Slider.
e Move the time slider to first time 2006 (if needed).
E e Click the Play button on the Time Slider to start the animation.

In this exercise you explored climate model simulations for Air Temperature Anomalies and
for a Drought Index using Esri ArcMap interface. You displayed and animated these data
over time to explore spatial patterns of warming and drought over the global cropland
regions.
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